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Getting Started… 

1. Attach your LilyPad Arduino to your computer and start the Arduino software 

 

2. Select the correct serial port 

Now you need to select the right serial port so that the Arduino software can talk to your LilyPad.  

Under the “Tools–>Serial Port” menu, choose the highest numbered COM port.  

 

Note: for either Mac or PC computers, you can also find the correct port by unplugging your board, looking at the menu, and then 

plugging your board in and looking at the menu again. The item that has appeared is the correct port. 



3. Select the appropriate board 

Now you need to select the right board, so that the software knows you’re using a LilyPad and not some other Arduino board. Under 

the “Tools–>Boards” menu, select the entry appropriate for the board you’re using. If you’re using a LilyPad Arduino SimpleSnap, 

LilyPad Aruduino Simple Board, LilyPad Arduino Main Board, or one of the LilyPad ProtoSnap Development boards, choose 

“LilyPad Arduino w/ ATmega328″. If you’re using a LilyPad Arduino USB Board, choose “LilyPad Arduino USB”. 

 

Basic Programming Steps 

Programming the LilyPad and executing your program takes place in four stages: 

1. Write a program 

First, you write your program. The Arduino environment lets you program in the programming language called C, which is what we’ll 

be using. You must obey the C language format for writing programs. 

2. Compile the program 

Second, you compile your program, translating the code that you wrote to code that the computer chip on the LilyPad can understand. 

If you’ve made any mistakes in your code, they will be detected during this phase and you will have to correct them and recompile 

your code before you move on to the next step. 

3. Load the program onto the LilyPad 



Third, you load your compiled code onto your LilyPad, moving the code from your computer to the LilyPad. 

4. The program executes on the LilyPad 

Once it has been loaded, your program executes on your LilyPad. The LilyPad does what you told it to do. 

  

Basic Code Elements 

So, that’s the process you go through in writing and executing a program, but how do programs work? Well, all programs execute in an 

orderly fashion, obeying your written commands (the lines in your program) line by line as they are written. There are a few different 

types of commands or code elements in most programming languages. To start with, we will use comments, simple statements and 

conditional statements. 

Since we will be using the C programming language, this section will describe what these elements look like in the C language, and we 

will be using the Arduino Language Reference to get more detailed information on how each code element works. 

1. Comments 

Comments are pieces of code that are ignored by computers. You can use them to make notes in your code, but they’re only for 

reference. They don’t affect the behavior of your program. Anything written on a line after two slash characters // is a comment. 

Comments show up a greyish brown in the Arduino window. Here’s are a couple example comments: 

// This is a comment. It doesn’t do anything. 

// Comments just make code easier for you and other people to 

understand 

Anything written between “/*” and “*/” characters is also a comment. Comments that start with “//” can only be on one line, but 

comments between the “/*” and “*/” characters can take up several lines. These types of comments will show up in that same greyish 

brown in the Arduino window so that you can always spot them easily. Here’s how we’d rewrite the comments above in this style: 

/* This is a comment. It doesn’t do anything. 

Comments just make code easier for you and other people to understand 

*/ 

Throughout the rest of this page, we will use comments as you would normally use them in a program, to explain what pieces of code 

are doing. Check out the Comment Page of the Arduino Language Reference for more information. 

2. Simple statements 

A simple statement is a single instruction. It takes up a single line and is always followed by a semi-colon. Here are some example 

statements: 

int ledPin = 13; // This statement declares a variable called “ledPin” and sets its initial value to 13. 

 // We’ll use “ledPin” later to control the LED that is on the LilyPad 

int switchPin = 2; // This creates a variable called “switchPin” and sets its initial value to 2 

http://www.arduino.cc/en/Reference/HomePage
http://www.arduino.cc/en/Reference/Comments


 // We’ll use “switchPin” later to read data from a switch attached to petal 2. 

int switchValue; // This creates a variable called “switchValue”, but does not initialize it 

delay(1000); // This tells the LilyPad to do nothing for 1000 milliseconds (1 second). 

digitalWrite(ledPin, 

HIGH); 
// This sets ledPin (pin 13 on the LilyPad as defined above) to +5 volts 

 // Setting pin 13 to +5 volts/HIGH will turn the LED on the LilyPad on. 

digitalWrite(ledPin, 

LOW); 
// This sets ledPin to 0 volts 

 // Setting pin 13 to 0 volts/LOW will turn the LED on the LilyPad off. 

 Notice how each statement is followed by a comment that describes what the statement is doing. 

To get a more thorough explanation of what each statement is doing, we would turn again to the Arduino Language Reference. The 

reference contains an entry for every simple statement form in the Arduino language. To understand the “int ledPin = 13;” statement 

better, see the variable declaration section of the Arduino reference. To understand the “delay(1000);” statement better, see the 

delay page of the Arduino reference. To understand the “digitalWrite(ledPin, HIGH);” statement better, see the digitalWrite page 

of the Arduino reference. 

3. Conditional statements 

Conditional statements are statements that consist of a condition and then a series of statements in brackets like this { } that execute 

when the condition is met. See the Control Structures section of the Arduino Language Reference for more information. Here are 

some example conditional statements: 

if (switchValue == 

LOW) { 
// This is the condition followed by the first bracket 

      

digitalWrite(ledPin, 

HIGH); 

// This tells the LED on the LilyPad to turn on 

} // Finally, you have the closing bracket 

Notice how the condition above consists of the word “if” and then a condition in brackets like this ( ). This is the basic form that a 

conditional statement always takes. To make sense of conditional statements, read through them as though they were regular english. In 

the case above, you would read it “if the variable switchValue is equal to LOW then turn the LilyPad’s LED on.” Here’s another 

example: 

while (switchValue == LOW) 

{ 
// This line is the condition followed by the first bracket 

      digitalWrite(ledPin, 

HIGH); 
// This tells the LED on the LilyPad to turn on 

      delay(100); // This tells the LilyPad to wait for 100 milliseconds. 

      digitalWrite(ledPin, 

LOW); 
// This tells the LED on the LilyPad to turn off 

      delay(100); 
 

      switchValue = // This stores a new value into the variable switchValue 

http://www.arduino.cc/en/Reference/HomePage
http://www.arduino.cc/en/Reference/VariableDeclaration
http://www.arduino.cc/en/Reference/Delay
http://www.arduino.cc/en/Reference/DigitalWrite
http://www.arduino.cc/en/Reference/DigitalWrite
http://www.arduino.cc/en/Reference/DigitalWrite
http://www.arduino.cc/en/Reference/HomePage


digitalRead(switchPin); 

} 
 

So, this statement would be read like this “as long as the variable switchValue is equal to LOW, do the following: turn the LilyPad’s 

LED on, then do nothing for 100 milliseconds (1/10th of a second), then turn the LilyPad’s LED off, then do nothing for 100 

milliseconds, then store a new value into the variable switchValue”. 

Arduino Program Structure 

The previous section looked at the different code elements of the Arduino language. Now let’s see how to put these elements together 

into a complete program. 

Each Arduino program has three main parts: a section where you declare variables, a “setup” section and a “loop” section. When your 

program executes, it will first define your variables, will then execute the setup section once and will then execute the loop section over 

and over. Here is a full example program in the Arduino window: 

 

 

First Program 

1. Open the Blink sketch 



Click on the Open icon (the upward pointing arrow in the Arduino software) and then browse to “01.Basics–>Blink”. You can also 

access this same example through the “File” menu. Go to “File–>Examples–>Basics–>Blink”. This will open the Blink “sketch” 

A little note about “sketches”: programs in Arduino are called sketches. All of your programs will be saved in your Arduino 

“sketchbook”. 

 

Your window should now look like the one below, with the Blink sketch loaded into the top half of the screen under a tab labled 

“Blink”. 



 

2. Compile the Blink sketch. 

Click on the Verify/Compile icon (the check button in upper left corner of the Arduino window). When you hover your mouse over the 

icon, text saying “Verify” will appear at the top of the Arduino window. 

 

The compiling process will take a few seconds. Once it’s done the Arduino window will tell you it’s “Done compiling” and will tell 

you the size of your sketch (the amount of memory it takes up). Your window should look something like this: 

http://lilypadarduino.org/?attachment_id=612


 

3. Load the sketch onto your LilyPad 

Click on the Upload button in the software (the right pointing arrow in the Arduino window). When you move your mouse over this 

icon, text saying “Upload” (or “Upload Using Programmer”) will appear at the top of the Arduino window. 

 

If all goes well, your window should look something like the one below when you’re done uploading. It will tell you that the upload is 

finished and give you the size of your sketch again. 

http://lilypadarduino.org/?attachment_id=613


 

 

Here are a few errors that you might encounter. These will appear in the bottom half of your screen. 

 



 

You didn’t select the correct serial port. Or, maybe your LilyPad isn’t actually attached to your computer. Double check your 

connections and see the setup page for instructions on selecting the serial port. 

Other errors? Check out ladyada’s fabulous help page and the Arduino Troubleshooting guide. 

4. Hey, it blinks! 

 

http://lilypadarduino.org/?page_id=1673
http://www.ladyada.net/learn/arduino/help.html
http://www.arduino.cc/en/Guide/Troubleshooting#upload


5. Play with modifying the code to get different behavior 

 Can you get the LED to blink faster or slower? 

 Can you get the it to blink in a heartbeat pattern? 

 How about getting it to flicker like a candle? 

Next Program: Sensing (Switches) 

1. Copy this sample code into an Arduino window 

(Switch Code) 

 

int ledPin = 13; 
// LED is connected to digital pin 13 

int switchPin = 2; // switch connected to digital pin 2 

int switchValue; 
// a variable to keep track of when switch 

is pressed 

    

void setup()   

{   

      pinMode(ledPin, 

OUTPUT); 
// sets the ledPin to be an output 

      pinMode(switchPin, 

INPUT); 
// sets the switchPin to be an input 

      

digitalWrite(switchPin, 

HIGH); 

// sets the default (unpressed) state of 

switchPin to HIGH 

}   

    

void loop() // run over and over again 

{   

      switchValue = 

digitalRead(switchPin); 
// check to see if the switch is pressed 

      if (switchValue == 

LOW) { 
// if the switch is pressed then, 

          

digitalWrite(ledPin, HIGH); 
// turn the LED on 

      }   

      else { // otherwise, 

          

digitalWrite(ledPin, LOW); 
// turn the LED off 

      }   

} 
 

2. Format the Code 



Under the Tools menu, select Auto Format. After you do this, align all of your comments (the statements in grey-brown following “//” 

on each line) so that they are in readable columns on the right hand side of the screen. This will help you read through the code. Here’s 

what my Arduino window looked like after I formatted everything: 

 

Read through the code to get a sense of what it is doing. The comments at the end of each line should help you understand what’s 

happening. Note that in the code we are listening for a LOW signal on the switchPin. We turn on the LED when the switchPin is 

attached to ground. As was mentioned earlier, when we put the two alligator clips together this is exactly what is happening: the 

switchPin is attached to ground via the clips. So, let’s test it out in the real world… 

3. Load the code onto the LilyPad 

Compile the code and load it onto the LilyPad. Do this by hitting the upload button in the Arduino window (that’s the right pointing 

arrow at the top of the Arduino window). 

4. See what happens when you close the switch! 

If you’re using the LilyPad Proto Snap Development Board, turn on the pre-wired switch. The green light (next to pin 11) should turn 

on. Trying changing the code so you can use the button on pin A5 to turn on the green light. 



 

5. Play with modifying the code to get different behavior 

 Can you get the LED to turn on when the switch is open and off when the switch is closed? (Basically swapping 

the behavior of the sample code.) 

 Can you get the LED to blink quickly while the switch is closed and turn off when the switch is open? 

 Something a little more challenging… can you get the LED to toggle on and off with each press of the switch? That 

is, the first time you press the switch, the LED turns on, the second time you press the switch it turns off, and so 

on? 

Color (LEDs) 



 

  

1. Attach the LilyPad to your computer and start the Arduino software 

2. Copy this sample code into an Arduino window 

(RGB LED example code) 

 
/*  

*LilyPad tutorial: color (RGB LEDs) 
 

* 
 

*Uses a LilyPad RGB LED module to play with 
 

*dynamic colored light. See this web color 

chart  

*for the (Red, Green, Blue) values of 

different colors:  

*http://www.visibone.com/colorlab/ 
 

*/ 
 

    

int ledPin = 13; // LED is connected to digital pin 13 

int redPin = 11; 
// R petal on RGB LED module connected to 

digital pin 11 

int greenPin = 9; 
// G petal on RGB LED module connected to 

digital pin 9 

int bluePin = 10;   
// B petal on RGB LED module connected to 

digital pin 10 

  
 

void setup() 
 



{   

        pinMode(ledPin, 

OUTPUT); 
// sets the ledPin to be an output 

        pinMode(redPin, 

OUTPUT); 
// sets the redPin to be an output 

        pinMode(greenPin, 

OUTPUT);  
// sets the greenPin to be an output 

        pinMode(bluePin, 

OUTPUT); 
// sets the bluePin to be an input 

}        
 

 
  

void loop()   // run over and over again  

{ 
 

         //Basic colors:   

         color(255,0,0); //turn the RGB LED red   

         delay(1000); //delay for 1 second   

         color(0,255,0); //turn the RGB LED green   

         delay(1000); //delay for 1 second   

         color(0,0,255); //turn the RGB LED blue 

         delay(1000); //delay for 1 second   

 
  

         //Example blended 

colors: 
  

         color(255,255,0); //turn the RGB LED yellow   

         delay(1000); //delay for 1 second   

         color(255,255,255); //turn the RGB LED white   

         delay(1000); //delay for 1 second   

         color(128,0,255); //turn the RGB LED purple   

         delay(1000); //delay for 1 second   

         color(0,0,0); //turn the RGB LED off   

         delay(1000); //delay for 1 second   

}   

 
  

void color (unsigned char red, unsigned char green, 

unsigned char blue) 

//the color generating 

function  

{   

         analogWrite(redPin, 

255-red); 
  

         analogWrite(bluePin, 

255-blue); 
  

         analogWrite(greenPin, 

255-green); 
  

}   

3. Format the code 

Under the Tools menu, select Auto Format. After you do this, align all of your comments (the statements in grey-brown following “//” 

on each line) so that they are in readable columns on the right hand side of the screen. This will help you read through the code. Here’s 

what my Arduino window looked like after I formatted everything: 



 

4. Load the code onto the LilyPad 

Compile the code and load it onto the LilyPad. Do this by hitting the upload button in the Arduino window (that’s the right pointing 

arrow at the top of the Arduino window). 

5. See what happens! 



 

6. Play with modifying the code to get different behavior 

 Can you get the RGB LED to change color when you press a switch? 

 Can you write a function that slowly changes the RGB LED’s color from red to blue? 

Sound 



 

1. Copy this sample code into an Arduino window 

Copy and paste the code into an empty Arduino window. 

speaker example code (ProtoSnap) 

/* 
 

*LilyPad tutorial: sound (for ProtoSnap Board) 
 

* 
 

*Uses a LilyPad speaker module to produce 

simple musical notes  

*For a chart of the frequencies of different 

notes see:  

* http://www.phy.mtu.edu/~suits/notefreqs.html 
 

*/ 
 

    

int ledPin = 13; // LED is connected to digital pin 13 

int speakerPin = 7; // speaker connected to digital pin 7 

int speakerPin2 = 12;  
// this is for ProtoSnap only (another buzzer 

pin is 12, we’ll ground this)  

    

void setup() 
 

{   

        pinMode(ledPin, 

OUTPUT); 
// sets the ledPin to be an output 

        pinMode(speakerPin, 

OUTPUT); 
// sets the speakerPin to be an output 

        pinMode(speakerPin2, 

OUTPUT);  
// For ProtoSnap only  

        // For ProtoSnap only: sets this as ground  

http://www.phy.mtu.edu/~suits/notefreqs.html


digitalWrite(speakerPin2, 

LOW);  

}        
 

    

void loop()   // run over and over again  

{   

         scale(); //call the scale() function 

         delay(1000); //delay for 1 second   

}   

 
  

void beep (unsigned char speakerPin, int 

frequencyinHertz, long timeInMilliseconds) 

//the sound producing 

function  

{ 
 

         int x;   

         long 

delayAmount=(long)(1000000/frequencyInHertz); 
  

         long loopTime = 

(long)((timeInMilliseconds*1000)/(delayAmount*2));  

         for (x=0;x<loopTime;x++)   

         {   

            digitalWrite(speakerPin,HIGH);   

            delayMicroseconds(delayAmount);   

            digitalWrite(speakerPin,LOW);   

            delayMicroseconds(delayAmount);   

          }   

 }   

    

void scale()   

 {   

          

  digitalWrite(ledPin,HIGH); 
//turn on the LED 

          

  beep(speakerPin,2093,500); 

//C: play the note C (C7 from the chart linked 

to above) for 500ms 

          

  beep(speakerPin,2349,500); 
//D 

          

  beep(speakerPin,2637,500); 
//E   

          

  beep(speakerPin,2793,500); 
//F   

          

  beep(speakerPin,3136,500); 
//G   

          

  beep(speakerPin,3520,500); 
//A   

          

  beep(speakerPin,3951,500); 
//B   

          

  beep(speakerPin,4186,500); 
//C   

          

  digitalWrite(ledPin,LOW); 
//turn off the LED   

 }   



 

2. Format the code 

Under the Tools menu, select Auto Format. After you do this, align all of your comments (the statements in grey-brown following “//” 

on each line) so that they are in readable columns on the right hand side of the screen. This will help you read through the code. Here’s 

what my Arduino window looked like after I formatted everything: 



 

3. Load the code onto the LilyPad 



Compile the code and load it onto the LilyPad. 

4. Listen! 

Your LilyPad speaker should be singing out a “do re me fa so la ti do” scale. The LED should be on while the scale is playing. If 

you’re not getting sound, double check your alligator clip connections. 

5. Making sense of things: sound 

So, a little bit about sound…Sound is air vibration. Different pitches are produced with different frequencies of vibration. Here’s a 

good little introduction to sound: http://www.fearofphysics.com/Sound/dist.html.  

 

 Note  Frequency (Hz) Wavelength (cm) 

C0 16.35 2100. 

C
#
0/D

b
0 17.32 1990. 

D0 18.35 1870. 

D
#

0/E
b
0 19.45 1770. 

E0 20.60 1670. 

F0 21.83 1580. 

F
#

0/G
b
0 23.12 1490. 

G0 24.50 1400. 

G
#

0/A
b

0 25.96 1320. 

A0 27.50 1250. 

A
#

0/B
b
0 29.14 1180. 

B0 30.87 1110. 

C1 32.70 1050. 

C
#
1/D

b
1 34.65 996. 

D1 36.71 940. 

D
#

1/E
b
1 38.89 887. 

E1 41.20 837. 

F1 43.65 790. 

F
#

1/G
b
1 46.25 746. 

G1 49.00 704. 

G
#

1/A
b

1 51.91 665. 

A1 55.00 627. 

A
#

1/B
b
1 58.27 592. 

B1 61.74 559. 

C2 65.41 527. 

C
#
2/D

b
2 69.30 498. 

D2 73.42 470. 

http://lilypadarduino.org/?page_id=655
http://www.fearofphysics.com/Sound/dist.html


D
#

2/E
b
2 77.78 444. 

E2 82.41 419. 

F2 87.31 395. 

F
#

2/G
b
2 92.50 373. 

G2 98.00 352. 

G
#

2/A
b

2 103.83 332. 

A2 110.00 314. 

A
#

2/B
b
2 116.54 296. 

B2 123.47 279. 

C3 130.81 264. 

C
#
3/D

b
3 138.59 249. 

D3 146.83 235. 

D
#

3/E
b
3 155.56 222. 

E3 164.81 209. 

F3 174.61 198. 

F
#

3/G
b
3 185.00 186. 

G3 196.00 176. 

G
#

3/A
b

3 207.65 166. 

A3 220.00 157. 

A
#

3/B
b
3 233.08 148. 

B3 246.94 140. 

C4 261.63 132. 

C
#
4/D

b
4 277.18 124. 

D4 293.66 117. 

D
#

4/E
b
4 311.13 111. 

E4 329.63 105. 

F4 349.23 98.8 

F
#

4/G
b
4 369.99 93.2 

G4 392.00 88.0 

G
#

4/A
b

4 415.30 83.1 

A4 440.00 78.4 

A
#

4/B
b
4 466.16 74.0 

B4 493.88 69.9 

C5 523.25 65.9 

C
#
5/D

b
5 554.37 62.2 

D5 587.33 58.7 

D
#

5/E
b
5 622.25 55.4 

E5 659.26 52.3 



F5 698.46 49.4 

F
#

5/G
b
5 739.99 46.6 

G5 783.99 44.0 

G
#

5/A
b

5 830.61 41.5 

A5 880.00 39.2 

A
#

5/B
b
5 932.33 37.0 

B5 987.77 34.9 

C6 1046.50 33.0 

C
#
6/D

b
6 1108.73 31.1 

D6 1174.66 29.4 

D
#

6/E
b
6 1244.51 27.7 

E6 1318.51 26.2 

F6 1396.91 24.7 

F
#

6/G
b
6 1479.98 23.3 

G6 1567.98 22.0 

G
#

6/A
b

6 1661.22 20.8 

A6 1760.00 19.6 

A
#

6/B
b
6 1864.66 18.5 

B6 1975.53 17.5 

C7 2093.00 16.5 

C
#
7/D

b
7 2217.46 15.6 

D7 2349.32 14.7 

D
#

7/E
b
7 2489.02 13.9 

E7 2637.02 13.1 

F7 2793.83 12.3 

F
#

7/G
b
7 2959.96 11.7 

G7 3135.96 11.0 

G
#

7/A
b

7 3322.44 10.4 

A7 3520.00 9.8 

A
#

7/B
b
7 3729.31 9.3 

B7 3951.07 8.7 

C8 4186.01 8.2 

C
#
8/D

b
8 4434.92 7.8 

D8 4698.64 7.3 

D
#

8/E
b
8 4978.03 6.9 

The LilyPad speaker (or “buzzer”) module works the same way any speaker does. It contains a material or device that moves in 

response to electricity. It is in one position when there is no voltage across the + and – petals on the speaker (when both petals are 

attached to – or set LOW), and another position when there is voltage across the petals (when one petal is attached to +5V or set HIGH 



and the other is attached to -). To use this device to create air vibrations, we need to get it to move between those two positions quickly, 

hundreds to thousands of times per second. How quickly we flip between the two positions (the frequency of the movement) will 

determine the pitch of the sound. 

6. Making sense of things: the code 

Now, let’s look at the code. The beep() function is the main sound producing chunk of code. Notice how the main part of the function 

is a loop where we set the speakerPin HIGH for a moment and then LOW for a moment. This is how we are producing sound. The 

pitch of the sound is determined by the “frequencyInHertz” variable and the duration of the sound is determined by the 

“timeInMilliseconds” variable. 

The scale() function gives an example of how to use the beep() function to produce specific musical notes. I used the frequency chart 

from http://www.phy.mtu.edu/~suits/notefreqs.html to find the frequencies for a basic musical scale. You can use that same chart to 

build your own musical libraries. 

7. Play with modifying the code to get different behavior 

 Can you get the LilyPad to play a tune when you press a switch? 

 Can you write a function that plays twinkle twinkle little star? 

 Can you write a function that creates a siren like sound (with smooth transitions between notes)?  

http://www.phy.mtu.edu/~suits/notefreqs.html

